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Disclaimer 

THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS DOCUMENT ARE SUBJECT 

TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS 

DOCUMENT ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, 

EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY 

PRODUCTS. 

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET 

FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED 

HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED 

WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY. 

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE 

SUPPLIERS ARE PROVIDED “AS IS” WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS 

DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF 

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM 

A COURSE OF DEALING, USAGE, OR TRADE PRACTICE. 

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, 

OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO 

DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS DOCUMENT, EVEN IF CISCO OR ITS 

SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
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Overview 
The Cisco Unified JTAPI Test Tool is designed to aid in the development of CTI applications. It 
provides a convenient and flexible way for you to test and validate applications so that you can 
ensure that they operate properly. The Tool provides a wide variety of features for testing 
operations that range from basic calls to invoking advanced API methods. 
 
The Tool is compatible with Cisco Unified Communications Manager 7.0.1 and above. 

Beta Release Disclaimer 
The Cisco Unified JTAPI Test Tool is designed to validate, troubleshoot, and aid in the 
development of CTI applications that complement Cisco Unified Communications Manager. This 
tool is currently in beta release and has not been tested or debugged for every scenario. Use of 
this tool should be limited to development, lab, or non-production systems. Care should be taken 
when running this tool on a production system during production hours. 

Before You Begin 
Download the ZIP file that contains the Cisco Unified JTAPI Test Tool files and expand the ZIP 
file into a folder on your local PC. The ZIP file is available at this location: 
 
http://developer.cisco.com/web/jtapi/docs 
 
In addition, make sure that Java 1.6 or later is installed on your PC. (To verify, open a command 
prompt and type java –version.) If necessary, download the current Java SE client. 

Starting the Tool and Connecting to a 
Provider 
To start the Cisco Unified JTAPI Test Tool, navigate to the folder on your PC in which you 
unzipped the files, and double-click JTAPITestToolVersion.jar. 
 
The Cisco Unified JTAPI Test Tool Initial window appears, as shown in Figure 1. 
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Figure 1    Cisco Unified JTAPI Test Tool Initial Window 
 
If you are starting the Tool for the first time, the fields in the Initial window are blank. When you 
start the Tool subsequently, it populates each field except the Password field with the information 
that was in the fields the last time that you clicked Connect. 
 
To use the Tool to connect to a provider, follow these steps: 
 

Step 1 In the Server field, enter the host name or the IP address of the Cisco Unified 
Communications Manager Provider to which you want to connect. 

Step 2 In the User field, enter the UserID that is configured on Cisco Unified 
Communications Manager Provider for the application user. 

Step 3 In the Password field, enter the password that is configured on Cisco Unified 
Communications Manager Provider for the application user. 

Step 4 (Optional) In the Parameters field, enter optional parameters of the providerString. To 
enter parameters, use the format argument=value. If you enter more than one 
parameter, separate each parameter with a comma (,). For example, enter 
InstanceID=100; CertStorePassphrase=”name” when establishing a TLS connection. 

Step 5 (Optional) Check the Add Call Observers On All Addresses check box if you want 
to open call observers on all devices that are associated with the application user. (A 
terminal must  be present in an application or end user control list.) 

Step 6 (Optional) Check the Register All Media Terminals check box to automatically 
register all media terminals that are associated with the user. 

Step 7 Click Connect to connect to the Provider. 

The Cisco Unified JTAPI Test Tool Main window appears, as shown in Figure 2. 
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Figure 2    Cisco Unified JTAPI Test Tool Main Window 

Main Window 
The Cisco Unified JTAPI Test Tool Main window (shown in Figure 2) appears when you use the 
Tool to connect to a Provider. This window includes the Kwik-E-Mart tab on the left side, the Tree 
panel on the top right, and the Event panel on the bottom right. The following sections describe 
the Cisco Unified JTAPI Test Tool features and functions in detail. 

Tree Panel 
The Tree panel displays all current objects that are in the Provider. Information displays in a tree-
like format, with the provider at the top followed by calls and addresses that are within your 
control list. In the tree panel: 
 
• Green items are in service and red items are out of service. 
 
• To determine the meaning of an icon, hover your mouse pointer over the icon to display a 

pop-up tooltip. 
 
• To expand an item so that you can see the items underneath it, click the Expand icon to its 

left: 
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• To collapse an item, click the Collapse icon to its left: 
 

  
•  You can right-click items in the Tree panel to perform various functions and configure the 

display. The following sections describe these procedures. 

Address(es) 
By default, the Tree panel displays calls and addresses. You can expand addresses to display 
terminals, and you can also choose to display call observers and address observers. Figure 3 
shows an expanded Address(es) list that displays terminals. (If the Tree panel displays the 
Terminal(s) list, you can right-click the Terminal(s) icon and choose Flip to display the 
Address(es) list.) 
 

  

Figure 3    Address List with Terminals Displayed 
 
To add observers on the Address(es) list, right-click the Address(es) item. A list of options 
appears, as shown in Figure 4. 
 

 

Figure 4    Configuring the Address(es) List 
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The options are: 
 
• Flip—Changes the display to show  the Terminal(s) list instead of Address(es) list. 

 
• Add Call Observers—Adds call observers for all addresses, which allows you to observe 

any call on the list of addresses. When you choose this option, a new call observer node 
appears under each address, as shown in Figure 5. In addition, each address for which 
you added a call observer becomes active. You can observe and monitor calls that are 
made to and from these addresses. The Icons for each Address node that you control 
change to indicate the new state.  

 

 

Figure 5    Address(es) List with Standard Call Observers Added 
 
• Add Observers—Adds an address observer to each address that is in the control list. This 

setting allows you to monitor events that occur at each specific address. See Figure 6. 
 

 

Figure 6    Address(es) List with Standard Address Observers Added 
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Terminal(s)  
If you configure the Tree panel to display terminals, the window displays information similar to 
what is shown in Figure 7. You can also choose to display call observers and address observers, 
and to register media terminals. (If the Tree panel displays the Address(es) list, you can right-
click the Address(es) icon and choose Flip to display the Terminal(s) list.) 

 

Figure 7    Terminal(s) List 
 
To configure the display of the Terminal(s) list, right-click the Terminal(s) item. A list of options 
appears, as shown in Figure 8. 
 

  

Figure 8    Configuring the Address(es) List 
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The options are: 
 
• Flip—Changes the display to show  the Terminal(s) list instead of Address(es) list. 

 
• Add Call Observers—Adds call observers for all addresses, which allows you to observe 

any call that is made on the control list of addresses. When you choose this option, a new 
call observer node appears under each address, as shown in Figure 6. In addition, each 
address to which you added a call observer becomes active. You can observe and monitor 
calls that are made to and from these addresses. The Icons for each Address node that 
you control change to indicate the new state. 

  
• Add Observers—Adds an address observer to each address that is in the control list. This 

setting allows you to monitor events that happen at each specific address in addition to 
monitoring the calls. 

 
• Register Media Terminal—Registers all media terminals that are within the control list. 

You must register a media terminal before you can use it. Registering a media terminal 
changes its icon to signify that it is active and in service, as shown in Figure 9. 

 

 

Figure 9    Left: Unregistered Media Terminal; Right: Registered Media Terminal 

Additional Functions 
The Cisco Unified JTAPI Test Tool provides a variety of additional functions for the items in the 
Tree panel. The following sections describe these functions. 
 
Address Functions 
 
To access additional functions for an address in the Tree panel, right-click an address. A list of 
options appears, as shown in Figure 10.  
 

 

Figure 10    Address Functions 
 
The options are: 
 
• Add Observer—Displays a sub-menu that provides the following options for adding a call 

observer or an address observer: 
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• Standard Call Observer—Adds a standard call observer to the address, if one has 
not been added already. 

• Special Call Observer—Adds a specific call observer to this address. When you 
choose this option, a new tab for this observer and address appears in the Event 
panel.  

• Standard Address Observer—Adds a standard address observer to the address 
node, if one has not already been added already. 

• Special Address Observer—Adds a specific address observer to the address. 
When you choose this option, a new tab for this observer and address appears in the 
Event panel. 

 
• Set Auto Accept—Causes all calls that are offered at CTIPorts or RP to be accepted by 

Cisco Unified Communications Manager. After you enable this option, an application does 
not need to accept a call. 

 
Terminal Functions 
 
To access additional functions for a terminal in the Tree panel, right-click a terminal. A list of 
options appears, as shown in Figure 11. 
 

 

Figure 11    Terminal Functions 
 
• Add Observer—Displays a sub-menu that provides the following options for adding a call 

observer or an address observer: 
 

• Standard Call Observer—Adds a standard call observer to the terminal, if one has 
not been added already. 

• Special Call Observer—Adds a specific call observer to the terminal. When you 
choose this option, a new tab for this observer and terminal appears in the Event 
panel.  

• Standard Address Observer—Adds a standard terminal  observer to the terminal, if 
one has not been added already. 

• Special Address Observer—Adds a specific terminal observer to the terminal. 
When you choose this option, a new tab for this observer and address appears in the 
Event panel. 

• Media Terminal Observer— Adds a media observer to the terminal. When you 
choose this option, a new tab for this observer and address appears in the Event 
panel. If the terminal is dynamically registered, a media terminal observer must be 
added. 

 
• Set Terminal Event Filter—Displays the Event Filter menu, as shown in Figure 12.This 

menu lets you set a variety of filters for terminal events. To set one or more filters, click the 
checkbox next to each filter that you want, or click Select All to choose all filters, then click 
OK. To clear filters, click Cancel then click OK. 
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Figure 12    Terminal Event Filters 
 
 
• Unpark—Unparks a parked connection.. 
 
• Terminal Control—–Displays a window that you can use to send XML objects to a device.  
 
• Register—Causes an application to register a media terminal for use later. This function 

provides a simple way to register a terminal because it uses the default object for 
registering. More advanced options for registering media terminals (CTI ports and route 
points) are available in the JTAPI tab. If the terminal is dynamically registered, a media 
terminal observer must be added. 

 
 

Removing or Renaming an Observer 
 
You can remove a standard call observer, and remove or rename a special call observer. 
 
To remove a standard call observer, right-click it then click Remove. See Figure 13. 
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Figure 13    Removing  a Standard Call Observer 
 
To remove or rename a special call observer, right-click it. The Remove and Rename options 
appear, as shown in Figure 14. 

 
 

 

Figure 14    Removing or Renaming a  Special Call Observer 
 
To remove the special call observer, click Remove. To rename the special call observer, click 
Rename. The Rename Observer dialog box appears, as shown in Figure 15. Type a name for 
the observer, then click OK. 

 

 

Figure 15    Rename Observer Dialog Box 

Call(s) 
The Cisco Unified JTAPI Test Tool provides a variety of functions that you can perform with the 
calls that are listed in the Tree panel.  
 
General Call Functions 
 
Right-click the general Call(s) node to display a list of functions, as shown in Figure 16.  
 

 

Figure 16    General Call(s) Node Functions  
 
The options are: 
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• Create Call—Creates a new call in the IDLE state, as shown in Figure 17. 

  

 

Figure 17    New Idle Call 
 
• Delete/Drop Call—Drops all calls that are listed.  

 
Idle Call Functions 
 
Right-click an idle call to display a list of functions, as shown in Figure 18. 
 

 

Figure 18    Idle Call Functions 
 
The functions for idle calls are: 
 
• Delete Call—Deletes the call and removes it from the Tree panel. 
 
• Connect—Makes the call an ACTIVE call. When you choose this option, the Connect 

dialog box appears, as shown in Figure 19. Enter a source address and a destination 
address for the call, separated with a space or a comma, then click OK. 

 

 
 

 

Figure 19    Top: Connect Dialog Box; Bottom: ACTIVE Call and Corresponding Connection 
 
• Consult—Allows a call in IDLE state to consult with another call in anticipation of a transfer  

or a conference. When you choose this option, the Consult dialog box appears, as shown 
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in Figure 20. Enter the address of a terminal connection and a destination address for the 
call, separated with a space or a comma, then click OK. 

 

 

Figure 20    Consult Dialog Box 
 
Active Call Functions 
 
Right-click an active call to display a list of functions, as shown in Figure 21. 
 

 

Figure 21    Active Call Functions 
 
 
The functions for active calls are: 
 
• Drop Call—Drops the call and removes it from the Tree panel. 
 
• Transfer—Transfers a call to a designated address. When you choose this function, the 

Transfer dialog box appears, as shown in Figure 22. To transfer a call, enter the address to 
transfer it to, then click OK. Figures 23 and 24 show the results of a transfer. 

 
Note: There may be several terminal connections per connection. In addition, the Tree 
panel displays the terminal physical device that is associated with a TerminalConnection. 

 

 

Figure 22    Transfer Dialog Box 
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Figure 23    Connections Corresponding to a Call, Including Connection ID and Address 
Associated with the Connection and the State 

 
 

 

Figure 24    Corresponding Terminal Connections for each Connection 
 
• Monitor—Allows you to monitor a call from a designated address. When you choose this 

function, the Monitor dialog box appears, as shown in Figure 25. To monitor a call, enter 
the address from which to monitor, then click OK. A new call is created and added. 

  

 

Figure 25    Monitor Dialog Box 

Connection(s) 
The Cisco Unified JTAPI Test Tool provides a variety of functions that you can perform with the 
connections that are listed in the Tree panel. Right-click a connection node to display a list of 
functions, as shown in Figure 26.  
 

Cisco Affiliates & Partners (CTDP) 
Copyright © 2008 Cisco Systems, Inc. All rights reserved. 
Page 15 of 32 



 

 

Figure 26    Connection Functions 
 
The functions are: 
 
• Park—Parks the call. 
 
• Disconnect—Drops the connection from a call. 
 
• Redirect—Redirects the connection to a designated address. 

TerminalConnection(s) 
You can place a device that is associated with a terminal connection on hold and take it off hold. 
To place a device on hold, right-click it and choose Hold. To take a device off hold, right-click the 
held device and choose Unhold. See figure 27. 
 

 

Figure 27    Top: Putting a Device on Hold; Bottom: Taking a Device Off Hold 

Provider 
The Cisco Unified JTAPI Test Tool provides a variety of functions that you can perform for the 
provider that is displayed in the Tree panel.  Right-click the provider to display a list of functions, 
as shown in Figure 28. 
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Figure 28    Provider Menu 
 
• Restart—Restarts the provider. 
 
• Shutdown —Shuts down the provider. 
 
• Add Observer—Adds a provider observer to the provider. 
 
• Register Features—Registers to receive a call park event. 

 
Parking Calls/Retrieving Parked Calls 
 
If an ACTIVE call is available, you can right-click a connection then choose Park. If parking is 
enabled on Cisco Unified Communications Manager, the connection parks at a parking address 
where it waits to be unparked up by a specific terminal. The park address is assigned by Cisco 
Unified Communications Manager. The call is updated with the park address and the address of 
the parked call. 
 
To unpark a call, right-click a terminal in the Tree panel and choose Unpark. Enter the parking 
address of the call than you want to unpark then click OK. 
 
Figure 29 shows a parked call. Figures 30, 31, and 32 illustrate unparking a call. 
 

 

Figure 29    A Parked Call with the Parking DN of 9999 
 
 

 

Figure 30    Selecting a Terminal from which to Unpark 
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Figure 31    Entering the Parking DN of the Call to Unpark 
 
 

 

Figure 32    Call Unparked from 2003 
 

Kwik-E-Mart Tab 
The Kwik-E-Mart tab lets you perform a variety of general call functions. Figure 33 illustrates this 
tab. 
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Figure 33    Kwik-E-Mart Tab 
 
The Kwik-E-Mart tab includes the following areas: 

 
• Kwik Call area—Allows you to easily make call. This area includes these options: 
 

• From field—Enter the source address for a call. 
• To field—Enter the destination address for a call. 
• View Events check box—Check to cause events for the call to display in a new 

Event window. 
• Call button—Click to initiate the call. 
• Clear button—Click to clear all entries in the Kwik Call area. 
 

You do net need to add observers in the Tree panel to use the Kwik Call function. This 
function adds observers automatically.   
 

• Kwik Conference area—Allows you to establish a conference call. This area includes 
these options: 

 
• Participants field—Enter the addresses of the participants that you want to include in 

the conference. Separate each address with a space or a comma. 
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• View Events check box—Check to cause events for the call to display in a new 
Event window. 

• Conference button—Click to initiate the conference. 
• Clear button—Click to clear all entries in the Kwik Conference area. 

 
• Kwik Redirect or Transfer area—Allows you to easily redirect a call from one address to 

another. This area includes these options: 
 

• From field—Enter the source address for a call. 
• To field—Enter the destination address for a call. 
• View Events check box—Check to cause events for the redirect to display in a new 

Event window. 
• Call button—Click to initiate the redirect. 
• Clear button—Click to clear all entries in the Kwik Redirect or Transfer area. 

JTAPI Tab 
The JTAPI tab provides features that allow you to execute JTAPI functions for the connected 
Provider. This panel accepts arguments from the Tree panel and lets you use Cisco JTAPI 
application programming interface (API) methods to perform operations on these arguments.  
To access the Command panel, click the JTAPI tab to the right of the in the Kwik-E-Mart tab. 
When the JTAPI tab first appears, it is blank, as shown in Figure 34.  
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Figure 34    JTAPI Tab 
 
To use the JTAPI tab, drag an object from the Tree panel to large pane in the Method List area.  
When you start a drag operation, a box appears next to the mouse pointer, which indicates that 
you are performing this operation on the highlighted object. See Figure 35. 
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Figure 35    Mouse Pointer when Dragging an Object to the JTAPI Tab 
 
After you complete a drag operation, the Text pane in the Method List area populates with the 
JTAPI methods that are available for you to use. Methods appear in alphabetical order and each 
includes its arguments and argument names. The text field that appears above the list of 
methods displays the current object. See figure 36. 
 
 

 

Figure 36    Method List Area after Dragging an Object  

Using Methods 
To use a method that appears in the Method List, click the method to select it. When you select a 
method, its required argument types, if any, appear in the order that they are required in the field 
at the top of the Argument List area. Figure 37 shows an example for the setMessageSummary 
method. The next expected argument type appears in green type. If the arguments extend 
beyond one line in the field, use the arrow buttons to scroll through the field. 
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Figure 37    Arguments List Area with Required Arguments for the Selected Method  
 
To designate the arguments for the method that you select, follow these guidelines: 
 
• Enter the expected argument that appears in green type in the field at the top of the 

Argument List area. 
 
• If an argument expects an object such as a terminal, drag the object from the Tree panel to 

the large pane in the Argument List area. 
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• The drop-down list under the Arguments List provides a list of definitions for certain 
arguments. You can choose a definition for the highlighted argument. 

 
• If an argument requires a Boolean entry, an integer, or text, enter the information in the 

field that appears near the bottom of the Argument List area then click Add Argument. 
(Enter a Boolean true or false value as text.) 

 
Figure 38 shows the Argument List area with the first required argument (Terminal) entered for a 
method. Notice that the next required argument (Address) appears in green type. 
 

 

Figure 38    Argument List Area with an Argument Entered 
 
To execute a method, make sure that you have entered all required arguments, then click Invoke 
Method, which appears at the bottom of the JTAPI tab. You can also execute a method by 
double-clicking it in the Method List area. By default, if a method includes “is” or “get” in its name, 
a pop-up window displays the information that is retrieved. See figure 39 for an example. 
 
If you right-click in the Method list area, a pop-up list of options lets you configure this display as 
follows: 
 
• Show “Get”/”Is” Only—Check this check box to display returned information for “get” and 

“is” methods. Uncheck this check box if you do not want to see this information 
 
• Show for All Methods—Check this check box to display returned information for all 

methods that return a value. 
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Figure 39    Information Retrieved from a Function  
 
 
Argument Area Options 
 
Right-clicking in the text pane in the Argument List area lets you access the Replace With and 
Insert functions, as shown in Figure 40. 
 

 

Figure 40    Replace With and Insert Functions in the Argument Area  
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The Replace With function lets you replace an argument with an argument of the same type. To 
replace and argument, left-click it to highlight it, then right-click it and choose one of the following 
options: 

 
• Replace With > From Tree—Replaces the selected argument with a selected object in the 

Tree panel. Click the replacement object (of the same type as argument to be replaced) in 
the Tree panel before you choose this option. 

 
• Replace With > From Fields—Replaces the selected argument with an item in the drop-

down list that appears below the Text pane in the Argument area. 
 
• Replace With > From Text—Replaces the selected argument with text that you first enter 

in the text field at the bottom of the Argument List area. 
 
• Replace With > Toggle True/False—Replaces a selected Boolean value with its opposite 

value. 
 

The Insert function lets you add arguments to the method that is highlighted in green in the field 
at the top of the Argument List area. Examples of arguments that you can insert include Boolean 
true/false values and a CiscoMediaCapability. 
 
To insert an argument, right-click the Text pane in the Argument List area, then choose one of 
the following options: 

 
• Insert > Insert ‘True’—Inserts a Boolean True value.  
 
• Insert > Insert ‘False’—Inserts a Boolean false value.   

 
• Insert > ‘CiscoMediaCapability[ ]’—Displays a window that lets you insert a 

CiscoMediaCapability Array for an appropriate argument (see Figure 41). The top pane in 
this window displays a list of available CiscoMediaCapability constructors and the bottom 
displays is a list of currently added objects. This window also includes these buttons: 

 
• Copy—Adds the selected CiscoMediaCapability object from the top pane to the end 

of the list in the bottom pane. If values are required, the Tool prompts you for the 
values. (See the Cisco JTAPI API documentation for additional information about 
required values.) 

• Clear—Removes all items from the bottom pane. 
• Add—Adds the items in the list of CiscoMediaCapability objects as an array in the 

text pane in the Argument List area. 
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Figure 41    Window for Inserting  CiscoMediaCapability[] Object 
 

• Insert > ‘Object[]’—Displays a window that lets you insert an array of objects for an 
appropriate argument (see Figure 42). You can drag objects from the Tree panel into the 
top pane of this window as needed. This window also includes these options: 

 
• Integer—Choose this option to add an array of integer objects. 
• String—Choose this option to add an array of string objects. Enter the string in the 

text field at the bottom of the window 
• Insert— Adds the objects in this window as an array in the text pane in the Argument 

List area. All objects must be of the same type. 
• Clear—Removes all items from the bottom pane. 
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Figure 42    Window for Inserting an Array of Objects 
 

• Insert > ‘Null’—Inserts a null object.  
 
• Insert > ‘CallControlFwd[ ]’— Displays a window that lets you insert an array of 

CallControlForwarding objects (see Figure 43). This includes these items: 
 

• Top pane—Displays the constructors that you can use and their parameters. 
• Destination field—Enter the destination number for forwarded calls. 
• Caller field—Not used in this release. 
• Drop-down list—Choose the type of call forwarding activity. 
• Internal Calls? check box— Not used in this release. 
• Copy button—Create a new instance of the selected constructor type with the 

designated values. 
• Clear button—Removes all items from the bottom pane. 
• Remove button—Removes the selected added instance from the bottom pane. 
• Insert button—Adds the instances in the bottom pane as an array of 

CallControlForwarding objects in the text pane in the Argument List area. 
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Figure 43    Window for Inserting an Array of CallControlForward objects 

Event Panel 
If you add observers of any type, the tabs in the Event panel display event information when you 
perform activities. 
 
Figure 44 shows an example of the Event panel in the default “table” view. In this view, the 
display identifies each event type by a specific color. 
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Figure 44    Event Panel in “Table” View  
 
You can choose the desired tab in the Event panel to view the information that you need. To 
close a tab, right-click the tab and choose Close.  
The columns in each tab resize automatically to fit the information that they contain. You can 
manually resize a column by dragging the right or left edge of its column heading. You can 
reposition a columen by dragging its column heading.  
To access options for the Event panel, right-click anywhere in the event display pane and choose 
Show Options. The Options area appears, as shown in Figure 45. To close the Options area, 
right-click in the event display pane or in the Options area and choose Hide Options. 
 

 

Figure 45    Options Area in the Event Panel  
 
The Options area includes these items: 
 
• Column list—Appears at the left of the Options area. When the Event panel is in “Table” 

view, this list indicates whether a column appears on the tab that is currently displayed. 
Indications are VISIBLE and NOT VISIBLE. To hide a column, click its name in the list then 
click the Hide button. To display a hidden column, click its name in the list then click the 
Unhide button. 

 
• Queue? check box—Queues events in the order that they occur. When you check this 

check box, events do not display in the Event panel. Instead, they are stored in a buffer. To 
display all events in the buffer, uncheck the Queue? check box. To display only the next 
event  in the buffer, click the Next Events button. 
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• Next Events button—When the Queue? check box is checked, displays the next event in 
the buffer. 

 
• Clear Panel button—Removes all events that are displayed in the Event panel. 
 
• Clear Queue? check box—If you check this check box, any items that are in the buffer as 

a result of checking the Queue? check box are removed when you click the Clear Panel 
button. 

 
• Text? button—Changes the display in the Event panel to “Text” view (see Figure 46). This 

view uses the same color scheme as the “Table” view. In addition, each pack of events is 
indicated by its header, which is highlighted in bright green. When you click this button, it 
toggles to  Table. Click the Table button to change the events display to “Table” view. 

 
 

 

Figure 46    Event Panel in “Text” View 

Cisco Unified JTAPI Test Tool Menus 
The Cisco Unified JTAPI Test Tool incudes the following menus in the menu bar at the top of the 
Main window: 
• Provider—Contains the New Provider option, which connects to another Provider. A new 

provider appears as a new tab in the Tree panel. 
 
• View—Contains options for showing or hiding all observers that you have set in the Tree 

panel. Choose View > Observers > Hide Observers to hide all observers in the Tree 
area.  Choose View > Observers > Show Observers to display all observers. Hiding 
observers does not remove them. 

 
• Help—Contains the About option, which displays the version of the Cisco Unified JTAPI 

Test Tool that you are using. 
 
 

Cisco Affiliates & Partners (CTDP) 
Copyright © 2008 Cisco Systems, Inc. All rights reserved. 
Page 31 of 32 



 

Cisco Affiliates & Partners (CTDP) 
Copyright © 2008 Cisco Systems, Inc. All rights reserved. 
Page 32 of 32 

Cisco Unified JTAPI Test Tool Icons 
The following table describes the icons that you might see in the Cisco Unified JTAPI Test Tool 
windows. 
 

Icon Meaning 

 
Address—in service 

 
Address—out of service 

 
Address list 

 
Call 

 
Call list 

 
Route address—in service 

 
Route address—out of service 

 
Route terminal—in service 

 
Route terminal—out of service 

 
Media terminal—in service 

 
Media terminal—out of service 

 
Terminal list 

 
TerminalConnection 

 
Terminal—out of service 

 
Terminal 

 
Connection 

 
Call observer 

 
Special call observer 

 
Provider—in service 

 
Provider—out of service 

 
 


